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Rotoscoping and More Compositing 
 

In This Chapter 

• Rotoscoping 

• Tutorial: Rotoscoping a Simple Image 

• Tutorial: Painting an Alpha Channel by Hand 

• Tutorial: Color Correcting Part of an Image 

• Tutorial: Exploding Heads 

• Special Effects 

• Making Your Video Look Like Film 

• Tutorial: Creating Film Grain 

• Rendering 

In Chapter 17, “Titling and Simple Compositing,” we introduced the concept of 

compositing, and showed you how you can render part of an image transparent—using a 

key or an alpha channel matte—to reveal another image lying below. In this chapter, 

we’re going to show you how to create more complex mattes, as well as how to touch up 

your composites with painting tools, and how to layer your composites to create more 

sophisticated effects. 

Why all this talk about compositing? Compositing features are the workhorse functions 

of any special effects process. Yes, you might have spent weeks creating maniacally 

detailed 3D models and animations of a thundering herd of gerbils, and the results might 

be incredibly detailed and realistic, but unless you can convincingly composite that 

animation onto your location footage of a plain in Montana, you won’t have a shot. No 

matter where your special effects content is created—painted by hand, shot with a film 

camera, generated by a computer—in most cases, it will need to be combined with live 

footage. 
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Even if your project doesn’t require any such special effects, you will need to understand 

the basics of compositing if you want to perform more complicated color correction, or if 

you want to fix technical problems such as drop-outs and glitches. 

For most of the tutorials in this chapter, we’re assuming you own copies of Adobe 

Photoshop and Adobe After Effects. Although you might be able to achieve some of our 

compositing and rotoscoping goals using your editing program, if you’re serious about 

any type of effects work, you really need a copy of After Effects. Demo copies of both 

applications can be downloaded from the Adobe web site. 

Our advanced compositing discussion begins with a digital update of a technique that is 

as old as cinema. 

Rotoscoping 
Put simply, rotoscoping is the process of painting, drawing, or scratching on a piece of 

film. If you ever shot super-8 footage as a kid and scratched laser beams directly onto the 

film, then you were rotoscoping. A more impressive example, though, is the epic Disney 

rotoscopes that can be seen in such productions as Cinderella. To achieve some of the 

extraordinarily realistic, fluid movement, animators painted over footage of live actors 

dancing and moving. 

The digital filmmaker has many applications for rotoscoping. At the simplest level, 

painting directly onto the frames of your video can be a brute-force solution for achieving 

certain types of effects. In fact, if you’re patient and talented enough, you could simply 

paint in all the effects you wanted! More practical examples of rotoscoping include 

removing wires from models or actors, touching up the seams in a composite, adding 

optical effects such as lighting changes, smoke, fire, or lightning, and performing color 

correction. In addition, rotoscoping tools let you create complex alpha channels that can 

be used for fine compositing work. 

In the next section, we’ll lead you through a number of rotoscoping examples and 

tutorials and, whenever possible, we’ll try to show you these techniques using 

applications that you already have. However, if your project will require a lot of 

rotoscoping effects, you’ll want to invest in a feature with some dedicated rotoscoping 

tools, such as Discreet Combustion, or Apple’s Shake. 
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As with the other effects topics that we cover in this book, rotoscoping can be a career in 

itself. Our goal here is to introduce you to some rudiments of the art, so that you can 

better understand how it might be useful to your production, and how you might 

personally use it to solve some problems. In addition, having an understanding of the 

basics will let you speak more intelligently, and interface better with the experts that you 

might hire for this type of work. 

Painting on Frames 
Just as Disney used to paint on celluloid, you can open up the frames of a movie and 

paint directly onto them using your familiar painting and image editing tools. Some 

programs such as Corel Painter allow you to directly open a QuickTime movie (Figure 

17.1). These programs provide a simple interface for painting on a frame, and then 

moving to the next or previous frame to continue painting. They also offer special onion-

skinning features that display a semi-opaque copy of one or more previous frames to help 

you position your paintings on the current frame. 

 

 

Figure 17.1 Corel’s Painter lets you open a QuickTime movie as a navigable series of individual 
frames. You can then use Painter’s full set of painting tools for your rotoscoping chores.  
 
 
 

fig 17.1
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In addition, some programs provide special tools for painting over several frames at one 

time (for creating real-time, “painted on” effects) and for cloning from one frame to 

another—an ideal way to create certain types of effects. 

If you don’t have an app that can open QuickTime files directly, you can always use your 

favorite image editor or paint program for rotoscoping,  by first exporting video from 

your editing application using a format that your image editor can understand. Most 

editing and effects programs can export footage in a number of “still” formats. However, 

you’ll need to be careful about managing these images so that you can convert them back 

into video later. 

As we discussed earlier, most effects shots are fairly short, usually just a few seconds, 

sometimes even just a few frames. Consequently, you usually won’t need to move huge 

amounts of data around. If you’ll be rotoscoping in a painting or editing program, you’ll 

need to do the following: 

 • Isolate the section of video that you want to manipulate. 

 • Export that section as a series of numbered still images. The file format you choose 

should be one that can support the full range of color in your video and should, 

obviously, be one that your painting or image editing app can work with. Most NLEs and 

effects programs can export PICT, TIFF, or Photoshop format (you don’t want to use 

JPEG, GIF, or any other lossy, compressed format). When exporting, create an empty 

folder on your drive and point the exported files into that folder. Your editing package 

will take care of sequentially numbering each image file. As long as you don’t change the 

name of any of these files, you’ll be able to easily re-import them later (Figure 17.2). 
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Figure 17.2 Adobe After Effects will let you save a movie as a numbered series of still images. 
You can open each image in a paint program or image editor for rotoscoping. 
 
 • Using your image editor, open, paint, and resave each file without changing its name. 

 • Import your numbered images back into your editing or effects application. Most apps 

have an option for importing a “numbered sequence.” This sequence will usually appear 

in your project window as a normal movie clip. 

Notice that by following this procedure, you will preserve your full image quality since 

you’ll never expose the frames to any compression. 

Filmstrip format 

If you’re working with Adobe Photoshop and Adobe After Effects, you use the 

Filmstrip format to move your video from application to application. (Adobe 

Premiere also supports this format.) Filmstrip format works just like exporting a 

series of numbered images, but instead of saving them as separate files, After 
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Effects exports all the frames in one giant tiled image. (Figure 17.3) You can open 

this single image and edit the frames accordingly in Photoshop and then re-save the 

image. The edited filmstrip file can then be imported back into After Effects or 

Premiere and used to replace your original video. 

 

Figure 17.3 – If you’re working with Adobe Photoshop and After Effects (or Premiere) 

you can use Adobe’s Filmstrip format for moving your video into Photoshop for 

rotoscoping. 

The nice thing about the Filmstrip format is that it makes for easier file management. 

However, for long segments, it might tax your computer’s RAM more than a series of 

single frames will. In addition, you don’t get the onionskinning features that you get from 

an application that can open QuickTime movies, such as Corel Painter. 

Rotoscoping a Simple Image 
The easiest way to learn the workflow we just described is simply to try it. For this 

tutorial, we’re going to return to the “hand-gun” movie that we developed in the last 

chapter. When we left off, we had just added a camera shake to make the firing of the gun 

more dramatic. Now we’re going to use some simple rotoscoping techniques to paint 

some lighting effects onto the movie. 

When the muzzle flashes, it should light up the hand, and possibly some of the shinier 

objects in the room. We could create a flash effect by applying a Levels filter to brighten 

the entire image, but this wouldn’t look quite right, as everything in the shot would be 
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brightened equally. We want to brighten just the objects that are near the flash; that is, the 

hand. 

As with the Camera Shake tutorial, we will be using After Effects and Photoshop for this 

example. 

Step 1: Open Your Project and Prepare 
Your Media 
Open the Camera Shake project that you created at the end of Chapter 17. Our plan is to 

rotoscope each frame where there is a muzzle flash. We don’t want to use the frame in 

our current composition, because it has been moved to create our shake effect. Instead, 

we want to manipulate the original image. Therefore, create a new composition and place 

the hand-gun.mov file into it. 

Step 2: Export Your Single Frames 
In your new composition, place the current time marker on the frame containing the first 

muzzle flash, and then select Composition>Save Frame As>File. Enter the name muzzle 

flash 1.psd and save the file. This will save the current image as a Photoshop file. 

Step 3: Paint It 
Open muzzle flash 1.psd in Photoshop. As we explained earlier, our goal is to add 

highlights to areas that would be flashed by the muzzle fire. Select the Dodge tool and 

paint the inside of the thumb, the front of the forefinger, and the tops of the other fingers 

that would be illuminated by the flash. You might also want to remove the shadow 

around the ring on the ring finger. You’ll need a small brush, and you might need to use 

several strokes. 

Now is also a good time to correct any weirdness in the muzzle flash itself. When we 

cropped the image, we ended up cropping a little too much off the left, resulting in a hard 

edge on the flash. Using the Smear and Clone tools, we can easily correct and reshape the 

flash. 

There are some dull specular highlights on some of the objects in the background, 

particularly the molding on the doorway frame, and the bright white rolls of paper. 

Brighten these highlights using the Dodge tool. When you’re done, save the image in 

Photoshop format (Figure 17.4). 
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Figure 17.4a,b You can use Photoshop’s Dodge and Burn tools to paint in a flash on the frame of 
video where the “gun” fires. 
 

Step 4: Import the Modified Image 
Back in After Effects, import your now-modified muzzle flash 1.psd image and place it 

into your camera shake composition. Place it in a layer above the hand-gun.mov layer, 

and position it so that it begins on the exact frame as the muzzle flash in the original 

movie. Shorten the layer’s duration to one frame (Figure 17.5). 

 

 

Figure 17.5 Position your still image in a layer above your video.  

In the previous tutorial, you repositioned the movie to make the camera appear to shake. 

Set the muzzle flash 1.psd layer to the same position as the movie. 

After Effects does not perform pixel aspect ratio compensation when it imports a 

Photoshop image. In other words, the imported image will be too wide because of the 

fig 17.03 a,b
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difference in DV’s rectangular pixels and the Mac’s square pixels. You can compensate 

for this by specifying DV pixel ratio in the comp. settings dialog. 

That’s it! You’ve effectively replaced the original frame with the new, modified one. 

Now you can perform the same procedure with the other muzzle flashes, and then export 

your rendered shot to your editing program. 

Whether working with single or still frames, the process just described is the basic 

workflow for rotoscoping. In the following tutorials, we’ll be using these same 

techniques to move video between compositing, painting, and rotoscoping applications. 

Rendering for DV Output 
If you will ultimately be putting your project back out to DV tape, 

it’s important to set the proper rendering settings when exporting 

clips from a compositing or effects package, especially if the clip 

you’re rendering incorporates video captured from DV. 

Because DV is interlaced, you should export your final renderings 

as interlaced output. DV is lower field dominant, so you’ll need to 

specify this at render time. 

Figure 17.6 shows the proper After Effects settings for DV 

rendering. These are the settings you should be using for the 

tutorials in this chapter. Note that if you ultimately plan on 

distributing via the Web, e-mail, or CD, you don’t need to worry 

about interlacing. 
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Figure 17.6 Render settings in After Effects. 
 
 

Better Rotoscoping through Filters 
As we saw in Chapter 16, “Color Correction,” most editing programs provide special 

effects filters such as the Color Balance and Levels filters that we used for color 

correction. Adobe After Effects-compatible filters have become something of a standard 

for effects plug-ins, and if your app supports them (or if you’re using Adobe After 

Effects), you can buy filters that do a lot of special effects tasks that have traditionally 

fallen into the realm of the rotoscoping artist. 

Often referred to as opticals, there are many effects that, until the advent of computers, 

were painstakingly rotoscoped by hand. Lightning bolts, sparks and flashes, laser blasts, 

and special color adjustments are all effects that can now be achieved automatically 

through filters. Although these filters don’t always provide exactly the effect you’re 

looking for, they often serve as an excellent starting point and can sometimes be 

combined with other filters and effects to get the desired look. 

fig 17.5
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As a reference, here are some of the packages we recommend for creating a variety of 

“optical” effects: 

 • DigiEffects’ Delirium is probably the most useful single collection of plug-ins that 

we’ve seen. Providing excellent Fire and Smoke filters, along with very impressive Rain, 

Snow, and Fairy Dust filters, Delirium provides an excellent balance of practical effects 

with fun, “trippy” effects (Figure 18.7). 

 

Figure 18.7 DigiEffects’ Delirium collection includes a number of excellent After Effects filters, 
including this very realistic Snowstorm filter. 
 
 • Alien Skin Eye Candy provides a number of improvements over After Effect’s built-in 

filters, including a Gaussian Blur filter that can extend beyond the boundaries of a layer, 

and an HSB Noise filter. Eyecandy also provides excellent filters for beveling, chiseling, 

and carving shapes out of a layer, as well as a nice filter for making a layer glow. 

 • Red Giant Software’s Image Lounge packs a variety of plug-ins. In addition to very 

stylized text, texture, and distortion filters, Image Lounge includes high-quality fire, 

clouds, and smoke effects, and unique to this package, special camera effects such as rack 

focus (Figure 18.8). 
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Figure 18.8 Red Giant Software’s Image Lounge collection is one of many packages that includes 
a fire filter. 

Stock Footage, or Filters? 
In Chapter 17, you saw how a number of effects can be achieved 

by compositing stock film footage with your video. Fire, smoke, 

lightning, gun shots, weather, and many other effects can be 

achieved by purchasing high-quality stock footage from companies 

such as ArtBeats. Alternatively, if you’re really resourceful, you can 

always create your own footage for compositing. 

However, as you can see from the list of special effects filters, 

there are a number of plug-ins that will also create fire, smoke, 

lightning, and even rain and snow. Therefore, which is the better 

choice? 

If realism is your primary concern, stock footage wins out over 

current plug-in technology. In addition, compositing stock footage 

with other video—even when using complex luma and chroma 

keys—will be faster than rendering effects with plug-in filters. 

On the other hand, special effects plug-ins offer a degree of 

control and scriptability that you’ll never get from stock footage. If 
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you need flame, for example, that flickers and flares at precise 

moments, or lightning that travels between two very specific 

points, then plug-in effects will be the better choice. In addition, 

plug-ins don’t take up additional storage on your drive the way 

stock footage can. Finally, filters can often interact automatically 

with other CG elements, such as the falling snow and logo shown in 

Figure 18.7. 

Ideally, of course, you want both, frequently mixed together—for 

good fire effects, for example, several layers of composited fire for 

realism mixed with plug-in fire effects for more control. 

 

Rotoscoping an Alpha Channel 
As we saw in the last chapter, an alpha channel matte is essential for compositing 

elements and layers that don’t have a background that can be easily cropped or keyed out. 

If your foreground element is computer generated—a 3D animation, for example—then 

your 3D animation package will probably render an alpha channel for you. However, if 

your foreground element was shot on video or film, then you’ll need to create an alpha 

channel by hand. 

Just as you can use rotoscoping techniques to paint into the image part of a piece of 

video, you can also use rotoscoping techniques to paint into the alpha channel of a piece 

of video to create complex, “hand-painted” mattes. As you’ll see in the following 

tutorials, you’ll often use a number of different tools and applications to rotoscope an 

alpha channel. (See Color Plate 15 for before and after shots of our intended effect.) 

Painting an Alpha Channel by Hand 
Painting an alpha channel by hand is often the only way to create a matte for a complex 

foreground. If your foreground plate contains a variably hued background that can’t be 

keyed, or a complex foreground with more detail than you can easily crop, then hand-

painting your alpha channel might be your only option. If this sounds tedious, don’t 

worry, there are a number of tips and shortcuts that make hand-cutting an alpha channel 

matte much simpler. 



 

The Digital Filmmaking Handbook  | © 2011 Ben Long and Sonja Schenk 

 

Open the Backyard Tutorial folder on the companion DVD and  look at the Backyard 

raw.mov file. You should see a 1.5-second establishing shot of a house (sorry, we’d love 

to have longer, more meaningful clips, but we felt it was more important to deliver a few 

full-res DV than lots of lower-res, smaller clips). Although the shot of the house is nice, 

we were originally envisioning a more dramatic sky. Our goal in this tutorial is to knock 

out the existing sky and replace it with something more dramatic. To do this, we’ll need 

to create a custom alpha channel matte to define transparency in our backyard raw layer. 

This layer, along with a more dramatic sky layer, will be placed in After Effects to 

produce a final composite. 

Step 1: Stabilize the Footage 
Unfortunately, our backyard source plate has a tiny bit of movement to it. Therefore, our 

first step is to stabilize the image. If the image is perfectly still, then we can create a 

single frame of alpha channel that can be used throughout the entire movie. If the image 

jitters or moves, then our alpha channel has to move in the same way. In the end, it’s 

easier to stabilize the shot than to create a jittery alpha channel. 

As we discussed in Chapter 17, stabilizing an image by hand is possible, but very 

difficult. Consequently, we’ve chosen to use Adobe After Effects Professional Edition to 

stabilize the image. The After Effects Professional Edition has an a very good motion-

tracking feature that can stabilize an image with the push of a button (well, two or three 

buttons, but it’s still very easy) as you can see in Figure 18.9. Note that the Standard 

Edition of After Effects lacks the motion tracking feature that is required for image 

stabilization. 

If you don’t have a copy of the After Effects Pro edition (or another compositor with a 

motion tracker such as Discreet Combustion), don’t worry, we’ve included a copy of the 

stabilized footage, called backyard stabilized.mov. 
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Figure 18.9 Stabilizing footage using Commotion’s Motion Tracker and Stabilize feature.  

 
Step 2: Create Your Project 
Load the backyard stabilized.mov file into After Effects and place it in a new 

composition. Since this footage is a stabilized shot, we don’t need to create an alpha 

channel for each frame in the movie. Remember, our goal is simply to eliminate the sky. 

The waving tree branches in front of the house don’t cross into the sky, so we can simply 

create an alpha channel for the first frame and trust that it will work for the entire movie. 

Save the document as backyard.ae. 

Step 3: Export the First Frame 
We will be creating our alpha channel in Adobe Photoshop, so our first task is to get the 

first frame of our movie into a form that will be usable in Photoshop. With the current 

time marker on the first frame of the movie, select Composition>Save Frame As>File to 

export this frame as a Photoshop file (Figure 18.10). 
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Figure 18.10 We can export the first frame of this movie as a Photoshop file, and then hand-cut a 
matte in Photoshop. 
 

Step 4: Open the Image in Photoshop and Start 
the Mask 
Take a look at the image and consider what will be required to cut a good mask. 

Fortunately, this image is pretty simple. The houses and chimneys all have a good, strong 

border. The only potentially troublesome area is the bush to the left side of the image. As 

we saw in Chapter 16, an alpha channel can be created in Photoshop by defining a 

selection, and Photoshop has a number of tools for creating selections. 

You could try to use the Magic Wand tool to select the sky, but since the sky is slightly 

cloudy, the Magic Wand won’t be able to zero in on a single color. Similarly, the sky is a 

little too mottled for Photoshop’s Color Range tool. If you’re using Photoshop 5.5 or 

later, you might be wondering why we aren’t just using the Magic Erase or the Extract 

command, both of which were designed to eliminate backgrounds. The problem with 

these tools is that they simply erase the background; they don’t define a selection or 

provide any way of translating the masking information that they generate into an alpha 

channel. 
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No, the easiest way out of this one is to paint the mask by hand. Fortunately, Photoshop is 

well equipped for this type of work. Click on the Photoshop QuickMask tool located at 

the bottom of the Tool palette. When in this mode, we can simply paint the areas that we 

want to mask. Masked areas will appear red. Grab a big brush and fill in the large, empty 

portions of the sky. Don’t worry about getting in close around the houses or foliage; just 

mask out as much of the sky as you can using a large brush. 

Change Your Cursor 

The rest of this lesson will go much easier if you go to 

File>Preferences>Display and Cursors, and set Painting Cursors to 

Brush Size. 

 

Step 5: Outline the Houses 
Now, grab a smaller brush and zoom in to the right side of the image. Our goal here is to 

create a tight mask around the houses. Fortunately, the houses are mostly made of straight 

lines. Click at the right edge of the image where the doorway meets the top of the frame. 

Position the edge of your brush against the line of the roof, and click. Follow the roof line 

and you’ll see that that edge goes for a short distance and then turns 90° to the left. The 

corner of that angle is the end of the first straight “segment.” Hold down the Shift key 

and click once at this corner. Photoshop will automatically connect your first click to this 

second click and create a straight line between. Continue outlining the houses using this 

manner until you reach the shrub. 

Step 6: Prepare for the Shrub 
Obviously, trying to paint around the shrub will be a frustrating exercise. Instead of 

painting around the shrub, make a couple of broad strokes around it to close it off from 

the rest of the image. Your painted areas should now look like Figure 18.11. Click on the 

Selection button at the bottom of the Tool palette (the button to the left of the QuickMask 

button). This will convert your painted areas into a selection. Save the selection into an 

alpha channel. We won’t be using this channel, but we’re going to save it anyway, just in 

case something goes wrong in the next step. 
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Figure 18.11 With the QuickMask tool, we painted around each house and up to, but not 
including, the complex shrub. We’ll add that selection later using a different tool. 
 

Step 7: Select the Shrub 
With your selection still selected, pick the Magic Wand tool. Hold down the Shift key 

and click on the sky-filled areas in the bush. With the Shift key held down, each Magic 

Wand selection will be added to your hand-painted selection (although the alpha channel 

you saved earlier isn’t being altered). Continue Magic-Wand-selecting the areas around 

the bush until you feel like you’ve selected all of the most conspicuous areas. Don’t 

expect to get rid of all of the varying hues of sky visible in the bush; don’t worry, we’re 

going to correct for those problems later. If you make a mistake that you can’t undo, 

press command-D to deselect, and then reload your selection from your alpha channel 

and start over with the Magic Wand. 

Step 8: Save Your Alpha Channel 
When you’re satisfied with your Magic Wand work, save the selection. Now, open the 

Channels palette and you’ll see you have two alpha channels. You can delete the first 

one, as it was our safety copy. Click on the second one to view it. The Magic Wand tool 

does not always create a smooth selection, so select the Blur tool and paint over the 

“bush” areas to smooth out, or feather, the Magic Wand selections that you made in Step 

7. Remember, the blurry, gray areas of the mask will be semi-opaque when composited 
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and will serve to smooth and blur the fuzzy bush shape into the background (Figure 

18.12). 

 

 

Figure 18.12 Our completed matte for the backyard footage. 
 

Save 9: Save Your Document 
Now we want to do something new. We want to apply this single alpha channel to each 

frame in our movie, so we need to export the alpha channel from this document, and then 

attach it to our movie in After Effects. 

From the Channels palette menu (the triangle thing in the upper right-hand corner of the 

Channels palette), select Duplicate Channel. For Destination, select New. Press OK, and 

a new document will be created that contains only our alpha channel. Before you save 

this document, however, you need to change its Mode to Grayscale. Select 

Image>Mode>Grayscale. 

Save the document in Photoshop format as backyard matte.psd. 

Step 10: Create Some Clouds 
Before we leave Photoshop, we’re going to create some clouds to place in the 

background. Although we could use stock footage of clouds, or render animated clouds in 

a 3D program, we’re going to stick with a simple still of some wispy clouds. Create a 

new RGB document measuring 720 by 640 pixels at 72 dpi. Click the foreground color 

swatch and select a slightly undersaturated, reddish-orange. Make sure the background 
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color swatch is white. Choose Filter>Render>Clouds. Voilà! Instant clouds. Save this 

document as a Photoshop document and call it clouds.psd. 

 

Step 11: Back to After Effects. 
Open the backyard.ae file that you created earlier. Import the backyard matte.psd 

document and the clouds.psd document. Place the clouds in your composition beneath the 

backyard stabilized.mov layer. You won’t see the clouds at all, since the backyard plate is 

obscuring them. Place the backyard matte document into your composition, and layer it 

above the backyard stabilized file. It should completely obscure the backyard stabilized 

layer. In the Timeline window, click the Eyeball icon in the backyard matte layer. This 

should make the matte layer invisible (Figure 18.13). 

 

 

Figure 18.13 Our AE project before activating our alpha channel. Note that the backyard matte 
layer has its visibility turned off. We don’t need to see it, we just need access to its luminance 
information.  
 

Step 12: Define the Alpha Channel 
Now we want to tell After Effects to use the backyard matte layer as the alpha channel of 

the backyard stabilized layer. Click on the backyard stabilized layer in the Time Layout 

window and choose Effect>Channels>Set Channels. Set Channels lets you redefine the 
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source of each channel in the current layer. We want to use our backyard matte document 

as the alpha channel for the backyard stabilized layer. In the Set Channels dialog, change 

the Set Alpha to Source pop-up menu to Luminance. In the field above that, set Source 

Layer 4 to backyard mask.psd. This tells After Effects to use the luminance information 

of the backyard matte layer as the alpha channel in the backyard stabilized layer. Because 

the backyard matte layer is all luminance (it’s black and white, no chrominance), it will 

correctly interpret our alpha channel. 

You should now see the clouds composited behind the houses! 

If there is slight fringing or other artifacts between the foreground and background, you 

can always go back to Photoshop and try to correct them. Before you go to that much 

trouble, though, render the file out (using the Animation compressor, of course) and 

import it into your editing program. Then, look at the footage on your NTSC monitor. 

You might find that any slight fringes are invisible. 

For a little extra drama, consider adding a slight movement to the clouds layer to make 

the clouds slowly drift behind the houses. 

 
 


